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Other WTP Events @

- Long Talks

Developing Data Tools with the DTP SQL Models and Parsers (Tues. 10:45)
EJB 3.0 Persistence and the Dali EJB ORM Project (Tues. 2:15)

What’s New in Web Tools 1.0 and 1.5 (Thurs. 9:45)

Using and Extending the Eclipse Web Tools Platform (WTP) (Thurs. 10:45)

Build JavaServer™ Faces Applications with the JSF Tools Project (Thurs.
2:15)

e Short Talks

Managing APIs with the Eclipse APl Scanner (Wed. 4:33)
The AJAX Toolkit Framework (Wed. 4:51)

Authoring in Eclipse (Thurs. 1:27)

Eclipse and Apache Derby (Thurs. 1:36)

What's new in WTP? Find out at the WTP project sprint!

Mon. 6:30-8:30pm, room 203
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‘ Web Tools Platform Project (WTP) veb ¢

e Top Level Eclipse Project
e WWW.eclipse.com/webtools/

e Development tools for web development
— No runtime dependencies
— Vendor extensible
e Subprojects
— Web Standard Tools (WST)
— J2EE Standard Tools (JST)
— JavasServer Faces Tools (JSF)

e Version 1.0 was released Dec 20, 2005.

e Dependencies
— Eclipse 3.1.2
— Eclipse Modeling Framework (EMF) 2.1.2
— Graphic Editor Framework (GEF) 3.1.1
— Java EMF Model (JEM) 1.1.0.1
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‘ WTP Subprojects

e Web Standard Tools (WST)

— Web artifacts
— Defined by open standards bodies

e J2EE Standard Tools (JST)

— J2EE components
— Java Community Process (JCP)
— Depends on WST

« JavaServer Faces Tools (JSF)
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Struts
Geronimo ITA ASP.NET
Velocity
1DBC Metadata
Tapestry VB Script
15P
JZEE 1.4
Hibernate
ColdFusion
Spring Tomcat
XDoclet EIR 115
XMLC JONAS
1Ms SVG
0Js Servlet
JavaScIipt
Webllorks
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‘ WTP Web Services Scope S

e World Wide Web Consortium (W3C)

— http://www.w3.0rqg
— HTML, XHTML, CSS, XML, XSLT, XML Schema, XML Query

< Organizations for Advancement of Structured
Information Standards (OASIS)
— http://www.oasis-open.orq
— e-Business standards for web services

e \Web Services Interoperability Organizations (WS-I)
— http.//www.ws-i.0rg
— Interoperable message exchange between web services
e Java Community Process (JCP)
— http://www.|cp.org
— Java Web Services APIs
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‘ WTP Installation Options S

e All-in-one
— Eclipse 3.1.2
— Eclipse Modeling Framework (EMF) 2.1.2
— Graphic Editor Framework (GEF) 3.1.1
— Java EMF Model (JEM) 1.1.0.1
e Update Manager
— Eclipse.org update site

e Plecemeal
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‘ Simple Object Access Protocol -

From the draft W3C specification:

SOAP is a lightweight protocol for exchange of
iInformation in a decentralized, distributed
environment. Itis an XML based protocol that
consists of three parts: an envelope that defines a
framework for describing what is in a message and
how to process it, a set of encoding rules for
expressing instances of application-defined
datatypes, and a convention for representing
remote procedure calls and responses.

http://www.w3.0rq/TR/soap/
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‘ WSDL

e Web Service Definition Language

e Describes
— What the service can do
— Where it resides

How to invoke it

e Elements
— Types - data type definition
Message - definition of data being communicated

Port Type — abstract set of operations

Binding — concrete protocol and data format

Service - collection of related endpoints
Port — binding and a network address
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‘ Apache Axis S

e Apache Web Services Project
e Open Source

e SOAP implementation

e Version 1.2.1

e http.//ws.apache.org/axis/

e Judd Solutions
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‘ Google Web Service Client oo 8

« \Web Service for searching

e http.//www.google.com/apis/index.html

— Download developer’s kit
= WSDL file
= Java wrapper library
< APl documentation

— Create a Google account
e License key
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‘ Consuming steps febs

1. Create Java Project
2. Generate Web Service Client from WSDL
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Create Project L

e Create a standard Java Project
e File > New > Project > Java x|

Create a Java project — J

P rOJ e Ct Create a Java project in the workspace or in an external location. i ,

Project name: | GoogleClient

— Contents

(# Create new project in workspace
(" Create project from existing source

Cirechonrys: | C:\devl\workspaces\eclipse2006\GoogleClient Browse, ., |

— DK Compliance

(& Use default compiler compliance (Currently 1.4) Configure default...

(" Use a project specific compliance: |14

— Project layout
(" Use project folder as root for sources and class files

(® Create separate source and output folders Configure default...

< Back | Mext = | Finish I Cancel |
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Generate Web Service Client @

e File > New > Other > Web Services > Web
Service Client

e Specify Java Proxy
: : X
- Test application websees o -

Review your Web service options and make any necessary changes / 3

before proceeding to the next page.

e Monitor traffic

Client proxy type: IJa'.fa Proxy j

[ Instal Web service client on server (managed ciients only)

[~ Test the Web service
[~ Monitor the Web service

[~ overwrite files without warning
[v Create folders when necessary
[~ Check out fles without warning

< Back | Next = | Finish I Cancel |
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Generate Web Service Client @

e Enter location of WSDL locally or via URL

il

Web Service Selection Page o

Enter a web service URL / a_

Enter an URI to a WSDL, WSIL or HTML document:

| fGoogleClient/GoogleSearch.wsdl

Select a WSDL

------ 2D file:/C:/devl/workspaces/eclipse2006/GoogleClient/GoogleSearch.wsdl

WSDL validation messages:

Seve... | line |c0|u... | message

< Back Next = Finish Cancel
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Generate Web Service Client @

e Specify project to generate the code in

ﬂ

Client Environment Configuration @ 5=

Choose from the list of supported runtimes and servers for the client / 3
environment, or use the default settings.

— Client-Side Environment Selection:
Web service runtime: Apache Axis
Server: Apache Tomcat v5.0

Edit...

Client Project type: I

Client project: | GoogleClient

Ll Lef L«

Client EAR. project: I

< Back Einish Cancel
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‘ Generate Web Service Client @

e Optionally, can specify namespace to
package mapping

ﬂ

Web Service ProxyPage 5

Select generate proxy if you want to generate proxy for your service. / 3

[¥ | Ganerate prosy

Output folder | fGoogleClient/src/java
[~ Define custom mapping for namespace to package.

[esit = Einish Cancel
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Output @

=524 GoogleClient

- Clasgeg 5% src/java
— DictionaryCategory & GoogleSearch
— GoogleSearchBindingStub =-J] DirectoryCategory.java
— GoogleSearchPort _'1] GoogleSearchBindingStub.java
— GoogleSearchPortProxy . E-[J] GooglesearchPort.java

[J] GoogleSearchPortProxy.java
_'ﬁ GoogleSearchResult.java
-] GoogleSearchService.java

— GoogleSearchResult
— GoogleSearchService

— GoogleSearchServiceLocator =-[J] GoogleSearchServiceLocator.java
— ResultElement &[] ResultElement.java
e AXis Jars B JRE System Library [jrel.5.0_06]
o @ axis.jar - F:\java\eclipse-3.1_wtp-1.0.1\ec|
- _aX'S'Jar_ ---g- commons-discovery-0.2.jar - F:\java\eclip
— Jaxrpc.jar & commons-logging-1.0.4.jar - F:\java\eclips
— saaj.jar & jaxrpcjar - F:\java\edipse-3.1_wtp-1.0.1}
— wsdl4j-1.5.1.jar ---!,,”- saaj.jar - F:\java\eclipse-3.1_wip-1.0.1\ec
- wsdidj-1.5.1.Jar - F:\java\eclpse-3.1_wtp-

— commons-discovery-0.2.jar

- commons-logging-1.0.4.jar *& buid

..... ‘EE? Erc
- ¥ GoogleSearch.wsdl
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Using Generate Classes [

GoogleSearchPortProxy proxy = new GoogleSearchPortProxy();
GoogleSearchResult result = proxy.doGoogleSearch(
"OcMw4/RQFHIXS 11w/ cAWwSFu******" = // key
"Bearable Moments', // query terms
0, // start index
10, // max results (<= 10)
true, // fTilter similar results
"', // subset restrict
true, // safe search
"', // language restrict
"UTF-8", // input encoding
"UTF-8'"); // output encoding

ResultElement[] resultElements = result.getResultElements();

for (int 1 = 0; 1 < resultElements.length; i1++) {
ResultElement element = resultElements|i];
System.out.printin(element.getTitle());
System.out.printIn(’* " + element.getURL());
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‘ Producing Web Services &

e Bottom up
— Java code -> Generate WSDL

e Top down
— WSDL -> Generate Java code
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‘ Bottom Up Steps e

1. Create Dynamic Web Project
2. Create Service and DTOs
3. Generate Web Service

e Judd Solutions



Create Dynamic Web Project &

e File > New > Other > Web > Dynamic Web Project
e Project Name
e Target server

# New Dynamic Web Project x|
Dynamic Web Project
Create a standalone Dynamic Web project or add it to a new or existing Enterprise | @
Application.

Project Name: | Order]

Project contents

[v Use default

Direchary; | C:\deviworkspaces\eclipse2 006\Order Browse,.., |
Target runtime: |Apache Tomcat v5.0 ﬂ New... |

[~ Add project to an EAR

EAR Project Hame: | EAR ﬂ =1 |

< Back Next = | Finish I Cancel |
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Create Dynamic Web Project

e Facets and versions

- New Dynamic Web Project
Select Project Facets

Enables the project to run webdoclet post processing on annotated servlets.

x|
/i

Presets: [gaellcyieljjd Save | Delets |
Project Facet | \ersion
o (> Dynamic Web Module 2.4 ...
- 5| Java 5.0 ...
--[] & wWebDoclet (XDocket)  1.2.3 ...
<< Show Runtimes
< Back Mext = Einish Cancel
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Create Dynamic Web Project > 8

e Context Root

e Directories

Web Module

x|
Configure web module settings. |f /

Context Root:

| order]

Content Directory:

| WebContent

Java Source Directory:

| src

< Back et = FEinish Cancel |
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‘ Create Service @

public class Order {
private static final float DISCOUNT = 0.9F;

public float quote(float price, iInt quantity) {
iIT (quantity > 100) {
price = price * DISCOUNT;
}

return price * quantity;
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Generate Web Service @

e New > File > Other > Web Services > Web Service

« Right click on Class > Web Services > Create Web
Services x|

Web Services (’3
Review your Web service options and make any necessary changes before proceeding to the next page. a

—Service

Web service type: |Bott0m up Java bean Web Service j
[+ Instal Web service on server

[v Start Web service in Web project

[~ Launch the Web Services Explorer to publish this Web service to a UDDI Registry

¥ Generate a proxy

— Client proxy

Client proxy type: IJava Proxy LI

[v Install Web service dlient on server (managed clients only)

[ Test the Web service
[+ ‘Monitor the Web service

[v' Qvenwrite files without warning
[V Create folders when necessary
[~ Check out files without warning

[~ Do not show me this dialog box again.

< Back Next = | Finish I Cancel |
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‘ Generate Web Service @ |

e Select class containing services to expose |f
not selected already

& web Service 5]
Object Selection Page q
Object Selection Page a
Bean: | com.juddsolutions.service.Order Browse classes... | Browse files... |
< Back Einish Cancel
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Generate Web Service @

=
® Se | e Ct {0 . e Ct fo § Service Deployment Configuration ¢
pro 2

d | Choose from the list of runtimes and deployment servers, or use the default settings.
p y Select the service project and the EAR project with which you want it to be associated.
d e S C rl pto rS If an EAR or project does not exist or is currently unassociated, it wil be created and

associated as required when you click Next.

— Server-Side Deployment Selection:

[ Create neW Cllent Web service runtime: Apache Axis

server: Tomcat v5.0 Server

project Edt.

Service Project type: |

Service project: | Order

Ll el L«

Service EAR project: |

—Client-Side Environment Selection:
Web service runtime: Apache Axis

Server: Tomcat v5.0 Server
Edit...
Client Project type: mamic Web Project |
Client project: | OrderClient Ll
Client EAR project: | |
< Back Finish | Cancel |
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Generate Web Service @

x
e Select methods to SE=Es x|

Web Service Java Bean Identity (’)
expose Configure the Java bean as a Web service. é
et Se I e Ct typ e Web service URI: | http://localhost: 8080/ order/services/Order
_ RPC WSDL Folder: | C:/devlfworkspaces/eclipse2006/Order/WebContent/wsdl
WSDL File: | Order.wsdl
e Performance
) I m | — Methods
S pie types - [] quote(float,int)

— Document

= Interoperability select Al| Deselect Al

e XML —Style and Use

{~ Document/ Literal (Wrapped)
" Document/ Literal

[ Define custom mapping for package to namespace.

= Back Hext = | Einish Cancel |
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Generate Web Service @

e Start server to host web service and test
client |

Server startup page q
Start the server from this page. h

In order to proceed the server "Apache Tomcat v5.0" must be started.
Once the server is started the "next” button wil be enabled.

The "back" button can be used while the server is starting to

change any previous settings in this wizard.

Currently the server is stopped. Sfart server

i< Back [ext = Eiriish Cancel |
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Generate Web Service

a Web Services Explorer - Microsoft Internet Explorer = |EI |i|

i TeSt early Fle Edit View Favorites Tools Help ) \ “

Qeak > ) ~ |x] (2] @» ‘ ) search 57 Favortes (@} Media @| b S_f F JJBE

Address |@ http://localhost: 62409/ wsexplorer/wsexplorer.jsp?org.eclipse.wst.ws.explorer=0 j
Links _J dntas |_J groovy _Jjava _Jjst _ltcms _Jweb i&]IDocs.com i&]XPlanner > @y
Google | || [Clsearch ~ | |2 Popups okay | “¥ Check v “A Autolink || | Autori »
Web Services Explorer B i
& web Service X —
2 . —I %5 Navigator o [# Actions @
Web Service Test Page : 2, WSDL Main P -
Select a test facility ' 5 4@ fie:/Ci/devijnorkspacesfeq | % Invoke a WSDL Operation e
B 2 OrderService
E- @) OrderSoapBinding Enter the parameters of this WSDL operation and ciick Go to invoke.
Test facility |Web Services Explorer j Launchl . Endoor 'za e
- Endpoin

| http://localhost: 10517 /order/services/Order Ll

price float

20

< Back Finish Cancel

quantity int

102
Go | Reset i

i status

source 4]
1=
w

«| > guoteReturn (float): 1836.0

|&] Done [ [ [ [ Localintranet 7
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‘ Generate Web Service @ |

e Directory for client code
e Optionally, provide namespace to

package mapping
x|

Web Service Proxy Page f;’
Select generate proxy if you want to generate proxy for your {. ;

Service.

[¥ Generate prosey

Output folder | /OrderClient/src

[ Define custom mapping for namespace to package.

< Back Finish Cancel |
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Generate Web Service @

e Methods to test from Sk &
. Web Service Client Test f’
teSt Clle nt Do you want to test the generated prosxy? é

[+ Test the generated proxy

Test facility IWEb service sample JSPs

15P project: |[Z}rdErCIient_.-'[jlrclerciieni?

Lef el Led

EAR projects |OrderClientEAR/OrderClientEAR

Folder: | sampleCrderProxy Browse... |

JSP folder: | {OrderClient/WebContent/sampleOrderProxy

— Methods

~[] setEndpoint(java.lang.String)
[] getorder()
- [v] quote(float,int)

Select All| Deselect Al

[T Run test on server

< Back

Einish | Cancel |
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Generate Web Service @

= Publish web service to UDDI registry

& web Service il
Web Service Publication f‘)
Do you want to publish your Web service? ﬂ. 5

[ Launch the Web Services Explorer to publish this Web service to the Unit Test UDDI Registry
[~ Launch the Web Services Explorer to publish this Web service to a UDDI Registry

Public UDDI Registry [18M UDDI Test Registry =l

HeExt = Einish Cancel
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Generate Web Service @

e Test Client

%) web Services Test Client - Mozilla Firefox =10l x|
File Edt View Go Bookmarks Tools Help

<@ -ty - & L) ) [0 hip:/focahost:s080 x| © Go [[Cl bearable moments

|7 dntas | groovy || Groovy Debugger j java || JDocs.com | jst ) tcms ) web

Methods - Inputs -
* g&tEﬂd:EDiﬂtE } price: IZD
+ setEndpomt{java lang. Strir .
* getOrder() quantity: |'ID2|

+ guote(float int

Invoke | Clear |

r o

Result 2l
1836.0

4| | >| ﬂ >|

| Done &
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Output \

=52 Order
=-E src

. B com.juddsolutions.servi
e Web Service 25 s

=4 JRE System Library [JDK 1.5.0_06]
=i Tomecat v5.0 runtime
=i Web App Libraries

-G WEB-INF
— WSDL &b
E|[c“b service
— Dynamic web app
----- server-config.wsdd
é---g% src
---m OrderService.java
E
-4 Tomcat v5.0 runtime
B
[
(> META-INF
[Z Result.jsp

=42 WebContent
E[& OrderService
E-E com
deploy.wsdd
deploy.wsdd.bak
_ P r O X ----- X web.xml
y == wedl
E|_'33 com.juddsolutions.service
=[] Order.java
: OrderServiceLocator.java
5[] OrderSoapBindingStub.java
+-=4 JRE System Library [JDK 1.5.0_06]
(= build
é--t} sampleOrderProxy
~[E Inputjsp
[Zl TestClient.jsp
= WEB-INF

descriptors 2 o verane
« Test Client e
‘- [E undeploy.wsdd
“ ¥ order.wsdl
_ J S PS =52 OrderClient
&-[J) OrderProxy.java
=) Web App Libraries
== WebContent
El Method.jsp
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‘ Data Types e

e Simple Java data types

e JavaBeans
— No parameter constructor

e Arrays
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‘ Test Client e 08

e http://localhost:8080/OrderClient/sampleOr
derProxy/TestClient.|sp?endpoint=http.//loc
alhost:10517/order/services/Order

) web Services Test Client - Mofilla Firefox _ 0] x|
File Edit WVew Go Bookmarks Tools Help

<,1§| S E:> & @ @ [ http:/flocalnost:8080 x| © Go |Gl bearable moments

) cntas ) groovy LI Groovy Debugger () java || JDocs.com [ jst [ tcms [ web =
Eecipse .. | [ Google... | || EdipseC.. | || EcipseT... | [ fie:...html || Web Se... |

Methods —Inputs -
. price:IIZD
' quantit}’:l'lDZ]
Invoke | Clear |
4 i
Result -
1836.0
J | o g -

I
?‘V
N
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TCP/IP Monitoring

« View SOAP request and response

Problems| Javadoc| Declaration | Console| Snippets| Properties| SN T TCF/IF Monitor

48T 0

=8 localhost:8209
PR /o cler\WS/services/Order

Request: localhost:8209
Size: 823 (1104) bytes
Header: POST forder\WS/services/Order HTTR/1.0

Byte | Response: localhost:8080
Size: 463 (603) bytes
Header: HTTP/1.1 200 OK

Time of request: 5:22.10.996 AN
Response Time: 831 ms
Type: HTTP

Byte -

< | LIﬂLI_I

<?xml wversion="1.0" encoding="UTF—8"?>;| <?xml version="1.0" encoding="utf—8"?>;|

ol
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‘ Web Service Explorer Testing

e Test any Web Services

a Web Services Explorer - Microsoft Internet Explorer -0 |i|
Fle Edit View Favorites Took Help ‘ "
Qe O v [x] 2] (] S search Jcravortss @veda | 0v T3 VBH Q@R B
Address |g"| http://localhost:51246/wsexplorer/wsexplorer.jsp?org.eclipse.wst.ws.explorer=0 j | Web assistant &
Links |_| cintas | _/ groovy | _Jjava _/jst _Jtcms |_/ web @JDocs.com @XPlanner @ Groovy Debugger XDoclet ‘ E
Gouglevl j| [Clsearch = | @M= g [ popups okay | “¥ Check ¥ A Look for Map ¥ | ALtoril fd options &
Web Services Explorer o
%= Navigator Actions @
% WSDL Main @ ) . (=
B4 platform:/resource/ Ticket/GoogleS Invoke a WSDL Operation =20urce
B C-"_‘n‘ GoogleSearchService
E1# GoogleSearchBinding Enter the parameters of this WSDL operation and click Go to invoke.
&8 doSpelingSuggestion End L
&8 doGetCachedPage ndponts
i JdoGooglesearch | http://api.google.com/search/beta? |
key string
OcMw4/RQFHIXS5I1w/c4Ww5fuiwbelL5a7
q string
Frlinse World h
i Status
Source
= return
~ directoryCategories
= DirectoryCategory
fulViewableName (string): Top/Arts/Music/Concerts_and_Events/Festivals/World -
4| v |4 »
2] [ [ | [%Jrocalntranet 4
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‘ WSDL Editor

e Graphically edit WSDL

Definition
Imports | | Types
Services Bindings Port Types Messages
B & OrderService B OrderSoapBinding B2 & Order = i
Bl & Order Il wsdlsoap:binding B 4 quote |—~> [ price (xsd:float)
I wedlsoap:address L = # quote Llinput [ guanity (xsd:int)
L@ wsdlsoap:operation M gutput [ quoteResponse

Llinput:
4l output
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Package @

e File > Export > WAR file

x

WAR Export

Export Web project to the local file system. 1 _@
Web module: | Order j
Destination: j Browse... |

[~ Export source files
[T Overwrite existing file

< Back HeERk = Finish Cancel
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‘ Deployment S

e Container specific

e Admin console

e Deployment directory
e Ant task

e Server View
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‘ WTP Resources @ g

e www.eclipse.org/webtools/
e WWW.pProjst.com

e Tutorials

— http://www.eclipse.org/webtools/community/communityr
esources.html#tutorials

e Articles

— http://www.eclipse.org/webtools/community/communityr
esources.html#articles

— Build rich Internet applications - http://www-
128.iIbm.com/developerworks/edu/os-dw-os-laszlo-i.html

e New Group
— news://news.eclipse.org/eclipse.webtools
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‘ Project Antoine

Help improve the Eclipse WTP user experience!

e What is this study about?

— UBC and IBM are conducting a usage study to improve
the organization of commands and functions in Eclipse
based projects.

e How can you take part?

— Simply install the study plug-in and use Eclipse WTP for your
daily work.

For more information, or to sign up, please Vvisit:
http://www.cs.ubc.ca/~lkf/antoine
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Contact Information @ '

 http://www.juddsolutions.com
e cjudd@juddsolutions.com

e Blog

— http://blogs.apress.com/authors.php?author=Christopher%20Judd

e Pro Eclipse JST

— http://www.projst.com
— http://www.apress.com/book/bookDisplay.htm|?blD=447

e Enterprise Java Development on a Budget
— http://www.apress.com/book/bookDisplay.htm|?blD=197

Pro Enterprise

. Java Development
E[:|I[JSE JST on a Budget

Fliag-ins tor JZEE Desnzlopmeent
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Questions ?

Please fill out your evaluations.

Judd Solutions



